
SWD HOSTING MANUAL 
 
 

 
CHAPTER ONE - GENERAL INFORMATION 

 
 

Sometimes setting up a new site, or even moving from one hosting company to 
another can be confusing and frustrating sometimes. We understand how that can be 
so to read through this Online Manual and if you still have questions, please submit 
your question to our support team.  

If you have not registered your domain yet you can register it with us at: 
http://www.swdhosting.com 

If you are transferring your domain or prefer to register it with another registrar be 
sure and use the nameserver information that was included with the email 
confirmation you received when your account was set up. 

Domain name registrations and transfers normally take 24-72 hours from the time 
you apply for your new account. Once your domain name is activated or transferred, 
you will be able to use yourname.com instead of your IP number.  Virtual IP 
accounts that do not have static IPs can be accessed this way: 
http://216.74.70.96/~yourusername/ 

Every customer gets his own password protected username under Linux. By logging 
in to his username, the customer gains access to his web storage space. Every 
username "owns" a structure of disk subdirectories in the Linux file system. The 
"root" of this structure is the "home" directory, found at path "/home/username". 
Note that this is somewhat similar to the MS-DOS directory structure, except that 
there is no drive letter and forward slashes are used instead of backward slashes.  

Inside the home directory is a subdirectory named "public_html". Every customer 
has his own separate "public_html" subdirectory. Files placed in "public_html" are 
visible to remote browsers over the Internet. As many clients are used to having 
their main directory refered to as "www", we have created another directory as such. 
When www is attempted to be accessed, the directory is automatically redirected to 
the correct public_html directory.  

For example, when a browser asks for URL http://yourname.com/page.html, Apache 
looks for the file /home/username/public_html/page.html and sends it out. If you 
have not registered "yourdomain.com" with InterNIC and specified our servers as its 
domain server, then the remote browser must ask for URL 
http://216.74.70.96/~yourusername/page.html to get the page, or the static IP 
number that you were supplied. Username/logins are always the first 8 digits of your 
domain name, or the the domain name itself if it is less than 8 digits. 
Example: 
The username for yourdomain.com would be "yourdoma". 

http://www.swdhosting.com
http://www.swdhosting.com/support.html


The username for here.com would be "here". 
Passwords are always 4-10 digits in length and are supplied to you when you set up 
your account. 

The filename of your home page should be index.htm or index.html. You must try 
them both, for each account may be set up differently, however, one of the two is 
sure to work. The web server will automatically send the file at path 
/home/username/public_html/index.htm or /home/username/public_html/index.html 
when a browser specifies http://yourdomain.com.  

 
 

CHAPTER TWO - CONTROL PANEL 

 
 

All accounts come with our Control Panel (cpanel). You can access your control panel 
at: 
http://www.yourdomain.com/cpanel/    or you may use, 
http://www.yourdomain.com:2082/  
 
(This will not be active until your domain has been transferred to our nameservers.) 
until then you will want to use the IP assigned to you when your account was set up. 
Virtual IP accounts that do not come with static IPs can access their control panel 
this way until your domain has been registered or transferred: 
http://216.74.70.96/~yourusername/cpanel/ or 
http://216.74.70.96:2082/~yourusername 

You will be asked to enter your user / password to gain access to your configuration. 
The control panel is pretty much self explanatory however a little information on the 
usage of each section is included below if you get confused along the way. All 
features are not available with all account plans: 

Password Changes 
This changes the passwords for your account, please make sure you close all existing 
windows that you have open for the Control panel. 
Note: This only changes your FTP and Control Panel password. If you use FrontPage, 
this does not change your FrontPage password.   

Shopping Cart (Not available for all plans) 
The Interchange Shopping Cart allows you to conduct business efficiently and 
professionally on the Internet. To install the Interchange Shopping Cart, simply click 
on the Interchange Shopping Cart icon in your Control Panel. To administer the cart, 
click the Admin Interface icon. Your initial username and password will be your 
control panel username and the password pass. For more information on the 
Interchange Shopping Cart, refer to the Interchange website. 

http://interchange.redhat.com/


Access Stats 
Provide access to many different programs that will analyze your access logs and 
show you more information about your web sites traffic.  

Database 
See Chapter 16 for instructions on how to setup a MySQL database. 

File Manager 
Allows you to modify the files in your web site in real-time via a web based interface. 
You can perform many commands such as chmod as well as actually edit the file and 
save it directly to the web server.  

Error Editor 
This is about as much customization as you can get folks! This section lets you 
customize the errors that your users will see instead of the generic server errors. You 
could setup a 404 page to redirect users to your main web site instead of the default 
dead document.  

Subdomain Manager 
Subdomains are a way of creating separate accounts within your master account, 
which are accessed as separate URLs. A subdomain creates a sub folder inside your 
public_html directory, of the same name as the subdomain. Upon creation, you will 
need to upload your files in this directory. Be sure to include an index page, such as 
index.html that will show by default. For more information on subdomains read 
Chapter 14. 

Web Page Protection 
Web page protection is used to limit access to any directory to users who enter a 
user/pass combo.  To protect a directory within your account:  
1.) Click on that dir.  
2.) Enter a user / password for access 
3.) Click add. You can add as many users as you wish to this file. This protection is 
for resources accessed via the WEB only, this will not create an FTP user.  

Mime Types 
A MIME type is basically what tells the web server that a .html document is a web 
page, and that a .gif doc is a gif image etc.  If you would like to configure a custom 
MIME type such as making .pictures a gif image file you would enter it here.  

Chat Room 
Allows you to access your personal chat server and supplies the code for you to use 
the product on your own site. If you would prefer a java chat, we have a special 
version of the Melange chat system installed on our servers.  This allows you to 
utilize Melange on your site without any installation whatsoever.  Simply place a link 
to the URL below on ANY page in your site, and you will be brought to your private 
chat room.   Below is the URL to your Melange chat room for: yourdomain.com 

http://yourdomain.com/cgi-sys/mchat.cgi?channel=yourdomain.com  

(Substitute your actual domain for "yourdomain.com") 



For more information on using the Melange chat system, please see the following 
URL: 
http://melange.terminal.at/doc/usrcommands.html 

 
E-MAIL 
E-mail control panel allows instant creation of e-mail POP3, forwards, and aliases.  
A POP3 account is a stand alone incoming e-mail account. if you create  

Mailbox name: john 
Password: doe  

all mail sent to john@yourdomain.com will be routed to the john e-mail account. The 
user john can then check this mail by login into mail.yourdomain.com using his user 
name and password. NOTE: the username is the full email address, so the above 
example would use john@yourdomain.com as the username.  

REMEMBER: all user names automatically have a determined amount of letters of the 
domain name appended to the beginning of the user name. So if john was a another 
domain user the user would use mail.somedomain.net as his incoming e-mail server 
and use powerjohn as his log in name to retrieve mail sent to john@homepage.net. 

An alias sends mail sent to one address to another POP3 account within your 
domain. For example if our recently created john account was going to receive all 
mail sent to sales@ourname.com we would setup sales as an alias to john. Note: by 
default all names not configured go to the root account. So if you sent a message to 
testl@yourdomain.com it would be sent to your main root account unless you had 
set it up as an alias, forward or POP3. A forward account sends mail sent to 
user@yourdomain.com to an address completely out of your domain. For example if 
john had an AOL account and wanted to check all his mail there you could setup john 
to forward to john3435@aol.com.  

Blocking E-Mail 
You can block email from a particular person, by using the "Block an Email" feature 
in your Mail Manager. To block an email follow these instructions:  

• Click on Add a Filter 
• Select the header information that you want to filter and enter the string that 

you want to filter out 
• Click Activate 

For example, to block an address from test@hotmail.com, select "From" from the 
header list, and equals from the matching list. In the textbox, enter 
test@hotmail.com. Click Activate, and you will none of your accounts will get any 
messages from this address. 

FTP Accounts 
Accounts Used for managing access accounts to your web space. The creation of an 
FTP account will allow users to log into a sub directory from your main account 
without gaining access to your main accounts. Sessions show any users that are 
currently logged into your domain.  

http://melange.terminal.at/doc/usrcommands.html


Settings allow you to modify access to your anonymous FTP site.  
(Not Available on Virtual IP Hosting Plans that do not have dedicated IP address) 
 
CGI 
We have numerous customizable cgi scripts that have been pre-installed on the 
server for you to use with your own account. The only thing you'll need to do is 
select the script you are interested in using, select the colors, style etc., and click the 
"Make HTML" button. You can then paste the HTML output into any of your HTML 
files to use that system cgi program.  

Counter - Allows you to keep track of the number of hits your website 
receives. 
To install a Counter for your site, click on the Counter icon. Change the 
options as you see fit, and name your counter. Then click the Make HTML 
button, and copy and paste that line into your HTML document. 

 
 

CHAPTER THREE - FTP & FETCH INSTRUCTIONS 
 
 

INTRODUCTION TO FTP 

We recommend WS_FTP- it is a standard FTP client for Windows Sockets. The 
graphical interface was designed with the novice FTP user in mind. This version 
features a reengineered FTP server detection and decoding process. Requirements: 
Windows 3.x or higher. 650 KB Download WS_FTP 4.5. 
 
All of your files and subdirectories go into your public_html directory.  DO NOT 
DELETE ANY DIRECTORIES OR FILES IN YOUR ACCOUNT. The files pertaining to your 
web site that you design should be uploaded to your public_html directory and 
should be the only files you ever replace. 

This is important -- you must transfer files in the appropriate mode.  

Perl scripts and HTML files are ASCII files, along with many others. If you use a plain 
text editor to work with a file, it's an ASCII file. It's not terribly important to transfer 
HTML files in ASCII mode, but it is important for Perl scripts.  

GIFs and JPEGs, as well as audio and video files, are binary files. They must be 
uploaded in binary mode, or will be corrupted. Files that look like garbage in a plain 
text editor and require a more advanced program to edit are not ASCII files, and 
must be transferred in binary mode.  

Now that we've distinguished where your files go and what format they should 
uploaded in, there are several ways depending on your computer system, that you 
can transfer files to your account directory. The process by which files are 
transferred to the web server is called "FTP" (File Transfer Protocol). You have 
unlimited access via FTP 24 hours a day. As such, you can create and maintain your 

http://www.download.com/cgi-bin/dl?18902-ftp://ftp.ipswitch.com/ipswitch/product_downloads/ws_ftple.zip


web pages on your own computer and upload files to your web site at your leisure.  
 
For the Macintosh, a program called "Fetch" is used, and for Microsoft Windows 
systems a program called "WS_FTP" is used.  
 
FOR PC USERS (WS_FTP) 
 
The following information is contained within your account activation notice and is 
needed to connect you to your web site via FTP:  
 
USERID 
PASSWORD 
FTP HOSTNAME 
 
Each time you run WS_FTP the Session Profile window will be displayed. A profile 
contains the information needed to connect to your web site. Creating a profile now 
will eliminate the need for you to configure the software each time you wish to 
connect to the web server via FTP. To create a profile, click the "New" button and 
enter a generic profile name at the top of the Session Profile window, such as "My 
Web site." Next, enter your Host Name/Address (yourdomain.com), User ID 
(yourdomain), and Password for your web site as illustrated below.  
 

 
 
Next you need to click "OK" to continue. This will connect you to the web server, 
where you will connect directly to the root ("home") directory of your account. 
WS_FTP will display a split screen where files on the left-hand side are within your 
own computer. You will see several folders on the right-hand side such as 
public_html which are landmarks suggesting a successful connection to your web 
site, as illustrated below.  
 
You need to double click on public_html to get to your web directory. This is where 
all your files will be downloaded, and/or you will create sub-directories. The only 
system directory that you may need to use is cgi-bin; this directory is reserved for 
custom scripts. To make your home page load automatically, name the HTML 



document "index.htm" or "index.html" in lowercase and upload it to the public_html 
directory of your account. To upload a file or files, simply highlight the file(s) on the 
left and click the right arrow button (->) in the center of the window. Be sure to 
upload HTML documents and scripts in ASCII mode and images in Binary mode. To 
transfer a file to a subdirectory, double-click the appropriate subdirectory to open it 
before transferring the desired file(s). To create a new directory, click on the MkDir 
button when you are inside the public.html directory or subdirectory.  
 
As soon as a file is uploaded to the web server, it is available for all to see. If, after 
uploading a file, you are still unable to see the updated file via Netscape, try hitting 
the "Refresh" or "Reload" button. If that fails, you need to clear both disk and 
browser cache. This function can be found by selecting Options>Network Preferences 
in Netscape. Remember that you must first be connected to the Internet through 
your local Internet service provider in order to connect to the web server.  
 
FOR MAC USERS (FETCH) 
 
The following information is contained within your account activation notice and is 
needed to connec t to your web site via FTP:  
 
USERID 
PASSWORD 
FTP HOSTNAME 
The hostname tells your FTP software to connect to the web server upon which your 
web site resides.  
 
Each time you run Fetch, the New Connection window will be displayed. A profile 
contains the information needed to connect to your web site. Creating a profile now 
will eliminate the need for you to configure the software each time you wish to 
connect to the web server via FTP. To create a new profile, select "New 
Connection..." from the File menu. Next, enter the Host (yourdomain.com), User ID 
(yourdomain), and password for your web site as illustrated below.  
 

 
 
Don't worry about the Directory option right now. When you have your Host, User 
ID, and Password entered, click on the OK button.  
 
The next window which will pop up will look similar to the one below, except that 



yourdomain will be in the pop-up window.  
 

 
 
Bookmarking the Connection 
 
You should take the time, now that you have established your connection, to make it 
easier for you to get here next time. Under the Customize menu, select New 
Shortcut. A window will pop up called Bookmark Editor, as below. It will already have 
your name, Host, and User ID filled in. Under Type, choose File from the pop-up 
menu. If you would like Fetch to remember your password so you won't have to type 
it in each time, type in your password in the Password field. Now, under the same 
Customize menu, choose Preferences, and under the General tab, make sure the 
connection you just entered is selected as the default shortcut. Next time you open 
up Fetch, your shortcut will be opened automatically and all you'll have to do is click 
the OK button!  
 

 



 
How to Transfer Files 
 
Refer again to the sample window above. You need to double-click on public_html  to 
get to your web directory. This is where all your files will be downloaded, and/or you 
will create sub-directories. The only system directory that you may need to use is 
cgi-bin; this directory is reserved for custom scripts. To make your home page load 
automatically, name the HTML document "index.htm" in lowercase and upload it to 
the public_html directory of your account. To upload a file or files, simply drag them 
from your hard drive onto the Fetch window when you are in the appropriate 
directory or subdirectory. Be sure to upload HTML documents and scripts in Text 
mode and images in BINARY mode. Or to make life easier, click on the Automatic 
button as shown in the sample window above, and Fetch will decide the proper 
format. To transfer a file to a subdirectory, double-click the appropriate subdirectory 
to open it before transferring the desired file(s).  
 
To insure that the Automatic selection works properly, make sure the selections 
under the Upload tab in the Preferences window looks the same as below.  
 

 
 
As soon as a file is uploaded to the web server, it is available for all to see. If, after 
uploading a file, you are still unable to see the updated file via Netscape, you need to 
hit the Reload button in the Netscape button bar. Remember that you must first be 
connected to the Internet through your local Internet service provider in order to 
connect to the web server.  

 
 

CHAPTER FOUR - TELNET ACCESS 
 
 

Logging into Telnet via SSH 



Telnet is available via SSH or Secure SHELL, you can download a popular telnet 
client from this site: 
http://vandyke.com (The most stable that we have found) 

Setup a new session in Secure CRT. Make the following changes:  
 
Choose SSH1 in the protocol and make sure cypher is 3DES and authentication is 
Password.  
 
Then just connect. You will get a message asking if you want to accept this key. 
Choose Accept and Save.  

 
 
 

CHAPTER FIVE - POP 3 EMAIL SETTINGS 
 
 

The setup of every single email item available to your account is automated by your 
/controlpanel.   (Located at http://yourdomain.com/cpanel/) Thus, there is no need 
to contact the technical staff to setup any of your pop3 accounts, forwards, aliases, 
lists, or auto-responders.  Simply check out the Email section of your /cpanel/, and 
then the various options within. 
 
Within each menu, there is a small help guide explaining the exact purpose of each 
item.  

It is a simple process to set up your accounts to send emails. We have included 
instructions for the four most popular email clients below. 

Outlook Express 
Eudora Lite 
Microsoft Explorer 
Netscape 
Microsoft Outlook 

OUTLOOK EXPRESS 

1. Click on the Tools menu and select Accounts.  

2. Click on the Add button and select Mail. This will bring up the Internet Connection 
Wizard window. 

http://vandyke.com/


 

 
 
3. For the Display name, enter your full name and click on the Next button. 

NOTE: You can use whatever you want here with both upper and lower case letters.  

 

4. For the Email address, enter: anything@yourdomain.com 



  

  

5. For the option my incoming mail server is a, choose: POP3  

6. For the Incoming mail (POP3 or IMAP) server field, enter: mail.yourdomain.com  

7. For the Outgoing mail (SMTP) server field, enter mail.yourdomain.com  

8. Click on the Next button to continue.  



 

9. For the POP account name field, enter your user name. Any pop 3 accounts that 
you setup will have your email address as the username. For example, if you request 
anything@yourdomain.com, the actual login for that pop3 box will be 
"anything@yourdomain.com"   So your username would be 
"anything@yourdomain.com". 

10. For the Password field, enter your password only if you want the program to 
save it. This allows you to check your e-mail without the need of typing in your 
password at the beginning of every session.  

11. Click on the Next button to continue.  



 

12. The next screen asks for Internet mail account name. You can leave this option 
at its default: mail.yourdomain.com  

13. Click on the Next button to continue.  

 



14. In this screen, choose the option I will establish my Internet connection 
manually.  

15. Click on the Next button to continue.  

 

16. Click on the Finish button and you're done! 

EUDORA LITE MAIL SETTINGS: 
 
This is a mail program that runs under MS Windows and Macintosh OS. Eudora 
connects to the mail server over the Winsock or Macintosh TCP/IP. Mail may be 
composed and read off line, but make sure that Winsock or TCP/IP is running before 
attempting to send or receive email. Although your account exists on our server, you 
won't be able to receive email at yourname@yourdomain.com until your domain 
name becomes live on the WWW.  
 
After Eudora has been installed, it must be configured to point to your server. To do 
this, start Eudora and select "Settings" from the menu bar. Most of the options are 
self explanatory. Here are the steps you need to perform to set up Eudora:  

 
(1) Select Tools...Personalities. 
(2) Right click the left-hand side of the screen. Select 'New'. 
(3) The 'New Account Wizard' will appear. Type in a name for this account and select 
'Next>'. 
(4) Select 'Create a brand new email account' and select 'Next>'. 
(5) Type in your actual name (not your email address) and select 'Next>'. 
(6) Type in the email address you wish for people to send email to (this can be an 
alias or a true POP box). Select 'Next>'. 



(7) Type in the true user for this POP box (this is NOT an alias). Select 'Next>'. 
(8) Select 'POP' for type of incoming mail server. Then type in 
mail.yourdomainname.com   in 'Incoming Mail Server' field. Select 'Next>'. 
(9) Select 'Finish'.  
(10) Right-click on the new personality created, and select 'Modify'. 
(11) In the 'SMTP Server' field, type mail.yourdomainname.com 
 
That's pretty much all the configuration Eudora needs. Many of the configuration 
areas will be filled in when you go to them, for instance it will usually fill in the POP 
account info where ever it needs it after you enter it the first time. Now, when you 
select "Check Mail" under the File menu, a window will pop up asking for your 
password. Enter in your password then click on the proceed button and Eudora will 
check to see if you have email. You can now send a test email message to yourself 
and then check to see if it gets returned to you.  
Once you have completed the above steps, you can now send email from your email 
client. The next step would be to create multiple accounts using your email accounts 
that you have created with your domain. When setting up additional accounts, you 
can use mail.mydomain.com for the outgoing email and using the return email 
address for your domain mail account. Your domain account 
(mail.mydomainname.com) would be your incoming SMPT and this would look 
something like this: (depending on what email accounts you have created) 
anything@yourdomain.com and then you would enter your username (remember 
your username will be the same as your email address) and password that you have 
setup for that particular email address. 
 
Your default email address is yourdomain@yourdomain.com, and that's where all 
your email will be sent to, unless other configurations take priority (such as 
autoresponders and redirects mentioned later).   
 
 
MICROSOFT INTERNET EXPLORER MAIL SETTINGS: 
 
The following samples assumes that your domain is mydomain.com  and your 
username is anything. 
 
Full name = name  
Email = anything@mydomain.com 
Internet Mail server = mail.mydomain.com  
Account = anything@mydomain.com (same as your email address) 
Pass = xxxxxx ( password) 
Smtp = mail.mydomain.com 
From = anything@mydomain.com (this can be set to any email account you have 
setup for your domain.  
 
 
NETSCAPE INTERNET MAIL: 
 
Your Name = name 
Email Address = anything@mydomain.com 
Reply to = anything@fred.com (this can be your email address for your domain) 
Mail Server username = anything@mydomain.com (same as your email address) 
Outgoing Smtp =  mail.mydomain.com  
Incoming Smtp= mail.mydomain.com 



To check numerous POP accounts, read the manual or help files that come with your 
email client software for configuration.  
 
If you are familiar with the shell (Unix) programs, "pine" and "mail", you can use 
either of these to check and send email as well.  

Netscape Communicator: 
1. After loading Netscape Composer, choose Edit -> Preferences 
2. Click on Identity 
3. Add your personal information. 
4. Click on Mail Server.  
5. The SMTP server would be mail.mydomain.com 
6. Virtual Domain Customers should enter their domain name for "incoming mail 
server". 
7. Put your username in the Mail server user name box. (username is same as your 
email address) 

Netscape Navigator: 
1. After loading Netscape Navigator, choose Options --> Mail and News Preferences 
2. Click on Identity 
3. Add your personal information. 
4. Click on Servers.  
5. The SMTP server would be mail.mydomain.com 
6. Virtual Doma in Customers should enter their domain name for "Incoming Mail 
(POP) Server". 
7. Put your username in the POP user ID: box. (username will be the same as your 
email address) 
 
 
MICROSOFT OUTLOOK MAIL SETTINGS: 
 
1. After loading Outlook, choose Tools... --> Services ... 
2. Click add, and choose Internet E-Mail. Click OK. 
3. In the General tab of the email Properties dialog box, fill in your personal 
information. 
4. Click on the Servers tab, and fill in the server information. The Outgoing Mail 
(SMTP) should be mail.mydomain.com. The incoming mail server should be 
mail.mydomain.com: Put in your mailbox username (username will be the same as 
your email address) in the account name field, and the password below. Click OK. 
5. Your new settings will not take effect until you choose Exit and Log off on the File 
menu, and then restart Microsoft Outlook. 

 
 

CHAPTER SIX - MAIL SERVER 
 
 

Understanding Your Mail Server 
As a linux customer, the setup of every single email item available to your account is 
automated by your /controlpanel.   (Located at http://yourdomain.com/cpanel/) 



Thus, there is no need to contact the technical staff to setup any of your pop3 
accounts, forwards, aliases, lists, or auto-responders.  Simply check out the Email 
section of your /cpanel/, and then the various options within. 
 
Within each menu, there is a small help guide explaining the exact purpose of each 
item. We have outlined a few additional points below: 

• Remember to always use "mail.yourdomain.com" as the incoming (pop3) and 
outgoing (smtp) server in your local email client, such as Outlook Express. 

• In the linux mail control center, the forwarding function provides forwarding 
to outer address, and can be used to alias one account to another.  Thus, if 
you want mike@homepage.net to head to a pop3 account of 
slim@aol.com, use a forward to make this happen. 

• Any pop3 accounts you setup will use your email address as the login. For 
example, if you request mouser@cheesewhiz.org, the actual login for that 
pop3 box will be "mouser@cheesewhiz.org". 

• If you forget the exact login of one of your pop3 accounts, simply head over 
to the "pop account" menu within your /cpanel/ to find out exactly what the 
logins are. 

• Your "default address" is the root catch-all mailbox. It receives messages 
heading to all addresses which aren't setup as unique pop accounts within 
your domain. Keep in mind that the default address account does NOT have a 
prefix, like other pop accounts. The login for your default address is the same 
as the main FTP login for your account. 

• If it seems that you cannot lock a pop3 account to retrieve messages for any 
reason, the quickest way to solve this for yourself is to delete and recreate 
the account with your /cpanel. This saves time as it bypasses asking our 
support staff for assistance. Yes, the changes you make to your email items 
with your /cpanel are done in real time. 

• The mailing list feature is very simple, please keep that in mind.  If you 
require a more powerful listserv program, you should probably look 
elsewhere.  We cannot utilize a robust listserv on our web hosting machines 
without causing the server's overall performance to suffer. 

• Hopefully this helps! Remember that the mail functionality for your domain 
won't be available on our servers until your entire domain is registered to our 
nameservers.  

Email Trouble 

If you are having problems related to receiving or sending email messages at your 
domain, this section is for you. Check through the headers below for help on the 
exact situation you are experiencing. Also, please be sure that your domain is 
registered and resolving on our nameservers before you start using the email 
services.  



Can't send mail: 
 
Our SMTP servers are configured as secure relays. This means that you cannot 
simply reference "mail.yourdomain.com" as an Outgoing mailserver unless you 
successfully log in via one of your pop3 accounts at "mail.yourdomain.com' before 
you try to send. This is a mandatory setting to prevent spammers from using our 
mailservers as havens for unsolicited email. If you are getting a "relaying prohibited" 
or "disconnected by administrator" error, it means that you haven't logged into the 
pop3 server at your domain before you tried to send through the smtp server at your 
domain. To log in, you need to check for mail first. 
 
In addition to this, you might not be able to send regardless of if you check mail 
successfully. Some ISPs have it set so that their users cannot use an outbound SMTP 
server to relay messages. If you are still experiencing problems sending through 
your domain, and are certain that you have logged in via pop3 to an account at your 
domain, you might want to contact your local ISP to see if they do allow their users 
to use outbound smtp servers. 
 
Finally, we'd like to clear up a common misconception of many users: the smtp relay 
you use to send out your messages has absolutely no bearing on the address your 
recipient sees as the sender. If you do end up having to use your local ISPs SMTP 
server, it will not prevent you from sending messages from address @yourdomain. 
For example, let's say that you have the domain "hompage.net". You can configure 
your email client to send from the address "admin@whatever.com" even if your 
outgoing (smtp) mail server is set as "mail27.prodigy.net" - your recipient will still 
see the message as being sent from "admin@whatever.com" regardless of the 
smtp server you use to send it. Be sure that your incoming (pop3) server is set to 
"mail.homepage.net", of course. 
 
Your default root email account: 
Every account starts out with a default "catch-all" account for its domain. This email 
box will grab all mail heading to ANYNAME@yourdomain.com. The login for this box 
is simply the same main account login you received after signing up. Thus, if your 
root account is "test@homepage.net" (login of "homepage" - first 8 letters of your 
domain), there is no need to request an alias to your root account, because all 
names under your domain already are filtered into this account. 
 
Can't lock account: 
A common cause of this is that the e-mail account is being accessed already or it is 
still open from another mail checking session. Solution: Retry in about 30 minutes. If 
it still does not work it is possible that you are using the wrong user / password 
combination.  
 
Please remember that POP accounts logins will use your email address as the 
login.The mail control panel of your account keeps this information for you, so please 
check there to correct any login problems. 
 
Any Username and Password Error:  
The main cause for this is trying to access the e-mail account with the wrong user / 
password. Remember you will use your email address as the login. If all else fails, 
simply remove, and then recreate the account with your mail control panel. 
 
If none of this helps, then most likely the pop3 box in question has a received a 



corrupted message. Contact our support team and tell them to clear that box out. 
Usually this results in most or all of that particular mailbox's contents being erased. 
 
Problems resolving your mailhost: 
If you find that you can't get "mail.yourdomain.com" to resolve as a valid SMTP or 
POP3 server, please be sure that your domain is registered to our nameservers. Also, 
try clearing out your cache and cookies and then restarting your computer.  

 
 
 

CHAPTER SEVEN - MICROSOFT FRONTPAGE 
 
 

NOTE: If your account is a Virtual IP Plan, please remember that your domain name 
will need to be activated on our nameservers before FrontPage will be available to 
your account. 

Basic FrontPage Instructions 

Login: Choose "Open FrontPage Web" from the File Menu in FrontPage Explorer. It 
will ask you for a Web Server of File Location. Enter yourdomain.com and then "list 
webs".    Next, you will need to select (double-click) the root web. The requested 
login and password will be the same as your FTP account. 

Usage:  FrontPage supplies you with two separate interfaces.  The FrontPage 
explorer is used to manage the files within your web site.  If you open a file in your 
web site another program called FrontPage Editor will open.  When you are 
connected to your web then all changes made to any file you edit will be saved to 
your web. 
*Note: Although the software documentation states that you can create the site on 
your computer and then "publish" it to the web server, we do not recommend this.    
Many times publishing to the server from your computer will loose the Interactive 
web bots features that you may have setup when designing your site on your local 
computer.   We recommend that you create your entire site by being connected to 
your web and saving directly to the server.  To move files already created on your 
web site use the Import command found under the File menu within FrontPage 
Explorer to select the files to import to the server.  This is by far the best method for 
moving files from your hard drive to the server. 

Additional support documents and complete usage instructions can be found at 
Microsoft's official FrontPage Home Page. 

(Please note that the Our Technical Staff can not assist in client side 
FrontPage configuration, please check with Microsoft's Technical Support 
documents) 

  

http://www.swdhosting.com/support.html
http://www.microsoft.com/frontpage
http://www.microsoft.com/


MICROSOFT FRONTPAGE 98  

 
 
Publishing a Web 

After you have built your html documents and are ready to upload them to our 
server:  
 
1. Open the web you've created on your PC using FP Explorer.  
 
2. Choose File > Publish 
 
3. If your "Destination Web Server" doesn't appear in the Publish window (it won't 
the first time you publish to our server) CHOOSE "More Webs" and type the location 
of the web to publish to. Hit return. IMPORTANT: Use www.yourdomain.com as the 
Destination Web Server to publish to our server. Leave the "Destination Web Name" 
BLANK.  
 
4. You will be asked for your USERNAME and PASSWORD. This is your domain's 
USERNAME and your FrontPage PASSWORD (which may be different than your 
regular telnet/ftp/POP password). If you're not sure what it is or if you aren't allowed 
past this point, you'll need to contact us for a new FP password.  
 
5. You can watch the progression of the upload by looking at the bottom left corner 
of FP Explorer.   
 
 
Opening an Existing Web  
 
1. Open FP Explorer and choose File > Open Front Page Web.  
 
2. You can now choose to open a previously created web on your PC or your web on 
our server.  
 
3. Highlight the appropriate web or type in the web address (www.yourdomain.com) 
and click OK.  
 
4. Enter your USERNAME and FP PASSWORD if required.  
 
5. Make modifications and recalculate links if needed. (See FP help docs for info on 
when it's necessary to recalculate links.  
  
 
 
Troubleshooting Common Problems with FP98 
 
Getting error - "Root Web Busy"  
 
FTP or telnet to your site and remove the "service.lck" file in /www/_vti_pvt. This 
usually happens when an FP session is interrupted before completion.  
 



Server timing out when publishing large sites. 
 
This difficulty arises when the uploading link times out in the process of copying the 
web to our server. The only suggestion Microsoft has offered so far is to break the 
main web into a group of sub webs on your PC, then upload these individually. If this 
problem persists for you, please contact support.  
 
Getting Error - "Front Page Extensions not Installed" 
 
We often see this error being reported even when the extensions have been 
installed. If you get this error, please contact support and we'll make sure the 
extensions are installed and repair them if necessary. NOTE: The extensions are 
easily corrupted. Please use only FP Explorer to update your web site on the server, 
not FTP.  
 
I published but my web's not there!  
 
This will happen when the "Destination Web Name" is filled in when publishing to our 
server. 
 
This box should be left blank. If you put any other name in this box it will create a 
subdirectory off of your root web and copy all of your files into it. Your site will exist 
under a subdirectory instead of at the top level /www where it should be.  
 
My counter, bbs, guestbook, etc isn't working.  
 
These problems are generally due to incorrect permissions on either the directory, 
file(s) or cgi script(s) that are associated with them. Please don't change the 
permissions of your files or directories unless you have a specific reason for doing so 
and you know what effect it will have on your site.  
 
My forms won't work through the Secure Server.  
 
The call to a cgi script using the Secure Server must not be within a webbot. Use a 
normal cgi call in your html script for Secure Server calls.  
 
My search bot doesn't return any results. 
 
The /www directory must be world readable AND you need to recalculate links 
BEFORE publishing (or after editing directly on the server). If it still doesn't work: 
FTP to the server and go to the /www/_vti_txt/default.wti directory.Delete any files 
that begin with "ALL.". Don't delete any other files. Then using Windows Explorer, do 
the same thing on your PC. Recalculate links, test locally with your browser and 
publish.  
 
FP starts the Web Publishing Wizard when I try to publish.  
 
Cancel the operation and email support to have the FP extensions installed/repaired. 
 
Why is my page renamed on the server when I publish?  
 
The "Default Document" of your web is automatically renamed by the server to what 
is required by the configuration of the server. For example, if you've named the main 



page "index.html", it may be renamed "default.html". Just check the links to your 
main page to make sure they refer to it the same way.  
  

  

Microsoft FrontPage 2000 

  

This tutorial will guide you step-by-step through configuring Microsoft FrontPage to 
exchange files between your computer and your web site. 

In order to follow along with us, you'll need to have Microsoft FrontPage installed, 
and you'll need to be connected to the internet via your Internet service provider 

Create a Simple Page  

Before you can publish an html file to your web site with FrontPage, you must either 
have a page already created, or create a page. To create a page with FrontPage, 
follow these simple steps: 

1. With FrontPage open, choose File --> New. 

2. Type in "This is a simple test" 

3. From the menu bar, choose File --> Save As. 

4. Name the html file. 
(If this file is to be your homepage, be sure to name it index.html) 

Once you have the file saved to your hard drive, you are ready to publish the file. 

Publish Your Web Page. 

1. From the menu bar, choose File --> Publish Web.  



 

You'll get a dialog box like this: 

 

2. Click on the Options button 

You will see a dialog box like this: 



 

3. In box below Specify the location to publish your site to: enter the full URL for 
your site. 

4. If this is the first time you are publishing your site, select Publish all pages...  

5. Select Include subwebs. 

You should now have a dialog box that looks like this: 

 

Obviously, you will have put your real domain name instead of 'mydomain.com' 

6. Click the Publish button. 

You should now see a dialog box like this one: 



 

7. Enter your username and password. 

If you have entered all the details correctly, FrontPage 2000 will then publish your 
site. You will see a dialog box like this one when it has finished: 

 

8. Click Done. 

 
Further Microsoft FrontPage Support 

 
If you need further assistance using FrontPage, go to the FrontPage Home Page. 

 
 
 
 
 

CHAPTER EIGHT - ANONYMOUS FTP 
 (not available on Virtual IP accounts without a dedicated IP number) 

 
 

Anonymous FTP provides a way for visitors to your site to download / upload files to 
and from your account.  Users will be able to log into ftp.yourdomain.com with the 
standard anonymous user name and e-mail address as the password.  

Your anonymous FTP account is the public_ftp directory in your root directory. You 
can create user specified logins thru the browser control panel interface. Visitors to 
your anonymous FTP site are connected to your 'public_ftp' folder.   

http://www.microsoft.com/frontpage


 
ANONYMOUS FTP WARNINGS: 
 
Responsibility 
 
As the account owner, you are responsible for any and all files that are stored on 
your domain. This would include files that were uploaded by you as well as by 
anonymous FTP users. With the use of anonymous FTP, your site is susceptible of 
becoming a "warez" site. Typically, these are sites that are used by "hackers" to 
trade (upload/download) illegally pirated copies of software programs with one 
another. As the account owner, the complete content of your account is your 
responsibility. If your site becomes a trading post for "warez" programs, you may 
face legal action that can be taken against you by the programmers/software 
companies of the copyrighted software, in addition to your account being deleted 
from our servers. Please refer to our Policy, Guidelines, & Disclaimer for more 
information. 
 
Data Transfer 
 
Any and all FTP download transfers, anonymous FTP included, will be used in the 
calculation of the total data transfer for your account. If this total data transfer 
amount exceeds the limit that is set for your plan, you will be responsibility for any 
and all overage charges that occur. 

 
 
 

CHAPTER NINE - SITE STATISTICS 
 
 

Please use your control panel to check your stats. 
 http://www.yourdomain.com/cpanel/ 

 
 
 

CHAPTER TEN - PASSWORD PROTECTED DIRECTORIES 
 
 

To protect a directory within your account:  
 1.) Click on that dir.  
 2.) Enter a user / pass for access 
 3.) Click add. You can add as many users as you wish to this file. This protection is 
for resources accessed via the WEB only; this will not create an FTP user. 
 
 
 

CHAPTER ELEVEN - CGI BIN 
 
 

http://www.swdhosting.com/policies.html


CGI-bin Applications 

CGI stands for "Common Gateway Interface," a fancy name meaning computer 
programs running on the web server that can be invoked from a www page at the 
browser. The "bin" part alludes to the binary executables that result from compiled 
or assembled programs. It is a bit misleading because cgi's can also be Unix shell 
scripts or interpreted languages like Perl. CGI scripts need to be saved in ASCII 
format and uploaded to your server's cgi-bin in ASCII or text format. This is very 
important. 

CGI, Common Gateway Interface, includes programs that run on the server to 
enhance the quality and functionality of a web site.    There are many resources on-
line that allow the downloading of free cgi scripts.   
 
(For instance:  http://www.worldwidemart.com/scripts/ ) 
or ( http://cgi.resourceindex.com/Programs_and_Scripts/ ) 
 
We do allow running of cgi scripts on the server, however they must conform to our 
acceptable server resource usage policy. If we deem that a script is using an 
excessive amount of server resources, it will be disabled.  We do offer shell access to 
our servers for debugging or creating scripts- you will need Telnet access.    We 
highly recommend that you setup Linux as a second operating system on your own 
workstation, as the more you familiarize yourself with this operating system, the 
better it will perform for you.  As often as possible, however, our web servers should 
be used only to upload the fully debugged final version of a cgi script so performance 
and uptime for other customers on the server is not compromised. 

To keep our hosting prices as low as possible we do not keep a programmer 
on staff that can debug or install scripts for you. However we can refer you 
to a 3rd party programmer that can provide you that service for a fee if you 
need it.   

We have provided below some general information that will find helpful when 
installing cgi scripts.  

Before a cgi script will work certain modifications must be made to them.   Certain 
paths must be specified in some scripts.    After the "#" in the first line of the perl 
script, the path to perl must be specified.  /usr/bin/perl should suffice for this path.  
Below is a printout of a "whereis perl" from our system.  
 
perl: /usr/bin/perl 

Other common paths sometime needed for cgi scripts: 
Send Mail - /usr/lib/sendmail 
Date - /bin/date 

Also, often you will need to know the exact physical path to your root directory on 
the webserver your account exists upon.  On our newer Linux servers, the path to 
your root directory is: 
/home/username/ 
 
Obviously, substitute "username" with the login you were assigned when you first 

http://www.worldwidemart.com/scripts/
http://cgi.resourceindex.com/Programs_and_Scripts/


received your account details.  Also, keep in mind that when you configure your CGI, 
that your /public_html is included in your path.  For instance, if you have a 
guestbook.pl script in your /cgi-bin, the exact physical path to that file is: 
/home/username/public_html/cgi-bin/guestbook.pl 

The documentation of your program should tell you what lines that you need to 
changed in order to get your script up and running.  

When you have all your modifications made you will want to save the file as a .pl or 
.cgi file.  (Make sure to use a plain text format.)  When you upload the file DO NOT 
upload in binary mode, instead using ASCII.    Uploading in binary will cause the 
server not to recognize the scripts as executables.  Most FTP clients will upload .pl or 
.cgi files in binary mode by default so you will need to change this.  You will need to 
upload your scripts into your cgi-bin. 

Setting Permissions 
 
You can very easily change permission on your files in the File Manager option in 
your control panel. 

 
 
 

CHAPTER TWELVE - SECURE SOCKET LAYER (SSL) 

  

This is normally not a feature of our accounts. We can however provide you with a 
directory on a secure server that you can use to upload files that need to be 
accessed securely. If you need this contact support for the details.. 

The URL to your secure files would be something like this: 
https://swdhosting.com/yourdomain/yourfile.htm 

If it is a form that needs to be submitted you will need to add lines of code similar to 
this to your file: 

<form action="https://swdhosting.com/yourdomain/cgi-bin/formmail.pl" 
method="post"> 
<input type="hidden" name="recipient" value="address@yourdomain.com"> 
<input type="hidden" name="subject" value="Subject of Form"> 
<input type="hidden" name="redirect" 
value="https://swdhosting.com/yourdomain/thanks.htm"> 

 
 
 

http://www.swdhosting.com/support.html


CHAPTER THIRTEEN - CHANGING YOUR PASSWORDS 

  

Please use your control panel to change your passwords. 
http://www.yourdomain.com/cpanel/ 

Note: This only changes your FTP and Control Panel password. If you use FrontPage, 
this does not change your FrontPage password.   

 
 
 

CHAPTER FOURTEEN - SubDomains 

  

A SubDomain is a domain name that is based on your current domain name.   An 
example of a SubDomain of somedomain.com would be hellothere.somedomain.com. 
This feature is useful if you want to divide up your site into different sections.   The 
document root for your subdomain will be the subdirectory that has the same name 
as your subdomain prefix.  For example: 

http://testing.somedomain.com 
is the same as 
http://somedomain.com/testing 

Therefore, you should upload to your subdomain accordingly.   

Subdomains can be set up in your control panel. You will then need to make a 
subdirectory in your public_html directory for each of your subdomains.  

 
 
 

CHAPTER FIFTEEN - Preinstalled Cgi Scripts 

 
We have numerous customizable cgi scripts that have been pre-installed on the 
server for you to use with your own account. The only thing you'll need to do is 
select the script you are interested in using, select the colors, style etc., and click the 
"Make HTML" button. You can then paste the HTML output into any of your HTML 
files to use that system cgi program.  

 
 



 

CHAPTER SIXTEEN - MySQL 

  

Below are instructions on how to setup and configure MySQL for your 
account using the control panel. 

Go to your online control panel and click on the advanced menu. Once there you 
click on MySQL. First you create a database then create a user. After you have 
created the database and user you must then add the user to the database. To do 
this click on the drop down list box in the middle of the page and locate the specific 
user that is associated with the particular database and click add user. Be advised 
that the username which you created using the control panel will have the prefix of 
of your main account login name. (Ex: if your main account login name is joe and 
the MySQL user that you created is datab the control panel will create the mysql user 
joe_datab.  

Below is information on how to write database connection code using PHP.  

$connection = mysql_connect("localhost","mysql_login","password") or 
die("Couldn't connect to server.");  
$db = mysql_select_db("phpdevdb",$connection)  or die("Couldn't select 
database."); 

To use phpMyAdmin to manage your database, you can access phpMyAdmin at:  
http://www.yourdomain.com/phpmyadmin/ 

Due to the technical nature of Mysql we are not able to provide support. However we 
had listed many references below that you will find helpful.  

References and Tutorials 

Books 

MySQL and mSQL 
Randy Jay Yarge, George Reese, and Tim King 
O'Reilly & Associates 
ISBN 1565924347 

The Practical SQL Handbook: Using Structured Query Language 
Judith S. Bowman, Sandra L. Emerson and Marcy Darnovsky 
Addison-Wesley 
ISBN 0201626233 
 
Understanding SQL 
Martin Gruber 
Sybex 
ISBN 0895886448 



 
Teach Yourself Sql in 21 Days  
Ryan K. Stephens (Editor), Ronald R. Plew, Bryan Morgan, jeff Perkins  
Sams Publishing 
ISBN 0672311100 

Be sure to check for the most current edition. 

Web Sites 

The MySQL site has an SQL reference and lots of information about MySQL in 
particular.  

Beginning MySQL Tutorial 
http://www.devshed.com/Server_Side/MySQL/Intro/ 

Another SQL tutorial is available on the net at 
http://www.geocities.com/SiliconValley/Vista/2207/sql1.html  

Newgroups 

There are various newsgroups under the comp.database group which deal with 
databases. 
Always a good place to start. 

Mailing Lists 

The MySQL site lists in their documentation page a number of mailing lists 
concerning MySQL and SQL. 

 
 
 

CHAPTER SEVENTEEN -  FAQS 

  

How do I access my control panel? 
http://yourdomain.com/cpanel/ 
(Replace yourdomain.com with your actual domain name and login in with your 
username and password) 

What is SSH? 
SSH is similar to telnet, but it's more secure. It uses high level encryption and 
comp ression to make sure nobody can takeover or eavesdrop on your telnet session. 
We recommend SecureCRT  for client side SSH access. 

Do you allow the running of daemons or background programs? 
We may allow programs to run continually or intermittently in the background via 

http://www.mysql.com/
http://www.mysql.com/Manual_chapter/manual_toc.html
http://www.devshed.com/Server_Side/MySQL/Intro/
http://www.geocities.com/SiliconValley/Vista/2207/sql1.html
http://www.mysql.com/
http://vandyke.com/


"cron" jobs. These are considered on a one-to-one basis and an extra charge will be 
incurred based on system resources used and operational maintenance needed. 

What are all the files and directories in my home directory? 

public_html Your web directory. Place all html web files here. 
public_ftp Your anonymous ftp directory.  

What are all the files and directories in my public_html directory? 

index.htm Main page for website. Replace with your own. 
cgi-bin Directory for your cgi scripts. 

I am trying to FTP using WS_FTP but when I try to send I am getting a 503 
No Port Command Issued First error. 
Make sure you do not have passive transfer mode enabled in your ftp software. 

How do I run my own CGI programs? 
Put your CGI programs in the cgi-bin directory. Make sure you upload them in ASCII 
mode. 
Change permissions to 755 for the script (chmod 755 script-name) 
Access them via http://www.yourname.com/cgi-bin/script-name 

I'm getting 'Internal server error' running my Perl script. What's wrong? 
1. When executed, you must print an HTTP header followed by a blank line. The 
header must contain either a Content-type field or a Location field. 
   eg. print "Content-type: text/html\n\n";  
2.You have incorrectly set the path to Perl in your script. 
3. You have used invalid Perl arguments 

I'm getting 'file not found' running my script. What's wrong? 
Check the following: 
   1. script is located in your cgi-bin directory. 
   2. page that calls the script has the path properly specified 
   3. script has world read & executable permission. 

How do I use formmail? 
 
Formmail is a very easy to use form processor, simply place the following on any 
page after entering your domain.  You can change  this code to fit your specific 
needs. 

<FORM METHOD=POST ACTION="http://yourdomain.com/cgi-
sys/FormMail.cgi"> 
<input type=hidden name="recipient" value="sales@yourdomain.com"> 
<input type=hidden name="subject" value="Order"> 
<input type=hidden name="return_link_url" 
value="http://yourdomain.com/"> 
<input type=hidden name="return_link_title" value="Back to MainPage"> 



Be sure to replace yourdomain.com, with your real domainname.  

What are my Email Settings 
If your email address is joe@yourdomain.com, you would use the following info:  
 
Username: joe@yourdomain.com  
Password: yourpassword (This is the password you set when you added the pop 
account in your cpanel/ 
Mail Server: mail.yourdomain.com)  
 
How do I setup the extra POP accounts I'm supposed to have with my 
account? 
Simply use our online control panel to add these. 

I can't send email. What's wrong? 
Our SMTP servers are configured as secure relays. This means that you cannot 
simply reference "mail.yourdomain.com" as an Outgoing mailserver unless you 
successfully log in via one of your pop3 accounts at "mail.yourdomain.com' before 
you try to send. This is a mandatory setting to prevent spammers from using our 
mailservers as havens for unsolicited email. If you are getting a "relaying prohibited" 
or "disconnected by administrator" error, it means that you haven't logged into the 
pop3 server at your domain before you tried to send through the smtp server at your 
domain. To log in, you need to check for mail first.  
 
In addition to this, you might not be able to send regardless of if you check mail 
successfully. Some ISPs have it set so that their users cannot use an outbound SMTP 
server to relay messages. If you are still experiencing problems sending through 
your domain, and are certain that you have logged in via pop3 to an account at your 
domain, you might want to contact your local ISP to see if they do allow their users 
to use outbound smtp servers. Several large ISP's are in the process of blocking all 
access to port 25 (the SMTP port). A few hosts that are currently doing this are:  
  

Earthlink  
UUNet  
Prodigy  

 
(There are probably others, these are just the ones we are aware of) 
They do this so that you will be forced to use their outgoing SMTP servers. Instead of 
using mail.yourdomain.com as your outgoing mail server, you should use the SMTP 
servers that your ISP provides you with.  

Why do I get a "Relaying Denied: Authenticate with POP first" error when 
trying to send email through the server? 
You need to login to your pop account and check your mail first. The server has anti-
spam software installed that won't allow anyone to use the smtp server until they 
have logged in first. This keeps just anyone from connecting to the server and 
sending out thousands of messages. You may need to wait 20-30 seconds before 
trying to send mail again for the server process to recognize you after you check 
your mail. Once you have logged into the pop server and have been authenticated, 



you will be allowed to send mail for 30 minutes without having to login again. If you 
do login again, your 30 minutes will start from the time you logged in last. 

How do I create email aliases, and how do I redirect them? 
Simply use our online control panel to add these 

How do I access webmail with my browser? 
http://yourdomain.com/webmail/ 
(Replace yourdomain.com with your actual domain name) 
Log in with the pop account username and password. 

I've noticed the X-AntiAbuse entries on the e-mail headers, and I'm just 
curious what the purpose of them is.  
Here’s an example:  
 
X-AntiAbuse: This header was added to track abuse, please include it with 
any abuse report   
X-AntiAbuse: Original Domain - mydomain.com  
X-AntiAbuse: Originator/Caller UID/GID - [0 0] / [0 0]  
X-AntiAbuse: Sender Address Domain - yourdomain.com 

It's so we can identify spammers. It is especially helpful when someone is sending 
mail as "nobody" (using scripts, etc) 

Where are my access logs? 
If you use your online control panel, and goto "Access Stats" you have access to 
Analogue stats (ie raw) and Webalizer stats (these need configuration). 

How do I create a mailing list? 
See the control panel. 

Where can I get support for a mailing list? 
http://www.gnu.org/software/mailman/mailman.html - the home site of the maillist 
software and: 
http://www.aurora.edu/~ckolar/mailman/ a documentation page 
http://www.list.org/faq.html - A Frequently Asked Questions Page 
http://www.python.org/mailman/listinfo/mailman-users a users list 
http://www.python.org/pipermail/mailman-users/ mailing list archive to see if your 
question has already been addressed.  

What is the correct path to perl(and other programs)? 
Perl: /usr/bin/perl 
Send Mail - /usr/lib/sendmail 
Date - /bin/date 

How do I password protect my pages? 
Simply use the control panel and select "Webpage Protection" 

How do I create my own error pages? 
Select "Error Handlers" in the control panel. 

http://www.gnu.org/software/mailman/mailman.html
http://www.aurora.edu/~ckolar/mailman/
http://www.list.org/faq.html
http://www.python.org/mailman/listinfo/mailman-users
http://www.python.org/pipermail/mailman-users/


How can I tell how much disk space I have by telnet? 
Telnet in and execute the command:  
du -sm 
This will show you many megabytes you have used. Just subtract that amount of 
space your plan says you have and there you got it. 
 
 
 

CHAPTER EIGHTEEN - PHP/SSI  

  

 
PHP 

PHP is a server-side HTML embedded scripting language that was developed in C and 
is designed especially for working with relational database systems. 
 
A PHP program is embedded directly in the HTML document. It must have a .phtml 
extension in order for the server to look for PHP code in the document. Here is 
how you embed the PHP:  
 
<? 
insert PHP code here 
?> 

PHP is an excellent way to embed scripting languages such as C, Java, and Perl into 
your website's pages.  It is a very efficient way to implement advanced tasks such as 
database queries, as well.   

You can implement and maintain a mySQL database entirely with the use of PHP as 
well.  You might want to see this Introduction to PHP if you aren't sure what PHP is.  

These are some additional sites and resources which will help you learn and develop 
your PHP skills, as well as answer any questions that you may have. 

Learning PHP Resources  

• Official PHP Website Docs  
• Official Zend Website  
• DevShed PHP Section  
• PHP Wizard  
• PHP Builder  
• PHP.CodeBase.org  
• The PHP Resource Index 

   

PHP Programs and Directories  

• HotScripts PHP Section  

http://www.zend.com/zend/art/intro.php
http://php.net/docs.php
http://www.zend.com/
http://devshed.com/Server_Side/PHP/
http://www.phpwizard.net/
http://www.phpbuilder.com/
http://php.codebase.org/
http://php.resourceindex.com/
http://www.hotscripts.com/PHP/Scripts_and_Programs/


• Evil Walrus  
• PHP Code Exchange  
• PHP myAdmin (useful mySQL DB manager) 

   

Links to More PHP Resources  

• Linux Guruz PHP Resources  
• PHP.com Links Section  

 
SSI 
 
ABOUT SERVER SIDE INCLUDES 
A server side include, or SSI, is a piece of code that is embedded into an HTML page 
and interpreted by the server before the page is sent to the client's browser. SSI's 
allow you to include information in your HTML files like a file's date of last 
modification, another HTML file, a counter, or the output of any CGI script.  

Server Side Includes are server intensive. Because all files need to be parsed by the 
server, having all of your pages SSI would cut performance.  

Any file that has the extension .shtml will automatically be parsed by the 
server. You can use index.shtml instead of index.html as your default directory file.  

SSI COMMANDS 

o The INCLUDE Command  
o The ECHO Command  
o The EXEC Command  
o The FSIZE Command  
o The FLASTMOD Command  
o The CONFIG Command  

SSI Commands The following is a list of Server Side Include basics: A server side 
include command is contained within a comment tag: <!--#command 
argument="value" -->  

Syntax must be correct, or your include will not work.  

 
The INCLUDE Command 

To include the contents of another file in a shtml file, you use the include command.  

The include command has two possible arguments: virtual and file.  

"Virtual" is used when the path to the document is given relative to the document 
root (usually your www directory.)  

http://www.evilwalrus.com/
http://px.sklar.com/
http://www.phpwizard.com/projects/phpMyAdmin/index.html
http://www.linuxguruz.org/z.php?id=93
http://php.net/links.php


"File" is used when the path to the document is given relative to the shtml file itself. 
However, you cannot use "file" to go up a directory ( "../slime.html" won't work.)  

Say we want to include the file named "file.html" which resides in the same sub 
directory of as this shtml file.  

To include it using "virtual," you would use:  
<!--#include virtual="/mirror/ssi/file.html" -->  

 
This would return: This is from file.html  

To include it using "file," you would use:  
<!--#include file="file.html" -->  

 
This would return: This is from file.html 

The ECHO Command 

The echo command includes, or "echoes," the contents of an environment variable. 
Here are some examples showing the SSI tag and the results :  

<!--#echo var="DOCUMENT_NAME" -->  
This document is named: man7.htm  

<!--#echo var="DATE_LOCAL" -->  
You accessed this document: Tuesday, 03-Jan-98 14:02:35 EDT  

<!--#echo var="DATE_GMT" -->  
This is the same as the above, but in Greenwich Mean Time: Tuesday, 03-
Jan-98 18:02:35 EST  

<!--#echo var="DOCUMENT_URI" -->  
The URI (the path form document root) of this document is: 
/manual/man7.htm  

<!--#echo var="LAST_MODIFIED" -->  
This document was last modified: Friday, 01-Nov-96 15:22:57 EST  

<!--#echo var="HTTP_REFERER" -->  
The user came by way of a link from: 
http://www.liquidweb.com/manual/index.html  

<!--#echo var="HTTP_USER_AGENT" -->  
The browser used to access this document was: Mozilla/4.0b3 [en] (WinNT; I)  

Echo Command Values 

SERVER_SOFTWARE server application  
SERVER_NAME hostname of the server  
SERVER_PROTOCOL server protocol  
SERVER_PORT listening TCP port  
REQUEST_METHOD HTTP method used by the client  
REMOTE_HOST domain name of the client, note DNS option must be set  
REMOTE_ADDR IP address of the client  
AUTH_TYPE method that the client used for authorization  



REMOTE_USER username entered by the remote client  
CONTENT_TYPE MIME type of the content posted by the client  
CONTENT_LENGTH size of the data posted by the client  
DOCUMENT_NAME name of the document requested  
DOCUMENT_URI URL of the document requested  
DATE_LOCAL current date, format specified by the config command  
DATE_GMT The current GMT, format specified by the config command  
LAST_MODIFIED document modified date, format specified by the config 
command  
PAGE_COUNT number of hits on the current document since server came on-
line  
TOTAL_HITS number of documents server has served since coming on-line  
REFERRER The URL of the document the viewer came from 

The EXEC Command 

The exec command executes a Unix command or CGI script. It always takes the 
argument "cmd".  

<!--#exec cmd="/usr/bin/date" --> This executes the Unix date command.  
<!--#exec cgi="./hello.cgi" --> This executes the CGI script, hello.cgi.  

 
If you look carefully you will notice the second line uses the statement exec cgi 
opposed to the previous line which used exec cmd. The second line is calling a CGI 
script that was written, the first a UNIX command. Here is the perl code contained in 
hello.cgi:  

 #!/bin/perl  
print "Hello ";  
exit;  

All the environment variables passed to the CGI script are the same as those for the 
shtml file itself.  

So, you cannot pass a query string using a question mark (?), as in:  

 <!--#exec cmd="hello.cgi?query" -->  

The query string passed to the CGI script will be the same as the query string passed 
to the shtml file itself. If this file were referenced as "ssi.shtml?snort", than the word 
"snort" would also be passed to the "hello.cgi" script above. 

The FSIZE Command 

The fsize command returns the size of the specified file in bytes. It uses the 
argument "virtual," which is the path to the file is given relative to the document root 
(usually your www directory.)  

To find the size of picture.gif, you would use:  



 <!--#fsize virtual="graphics/picture.gif" -->  

This would return then return the file size.  

 Your probably now asking, what can I use this for? Example: You offer some files 
available for download on your site and would like to give people an idea of how big 
the files are.  

 The FLASTMOD Command 

The flastmod command returns the date the specified file was last modified.  

The flastmod command uses the argument "virtual," which is the path to the file is 
given relative to the document root (usually your www directory.)  

To find the last modified date of a file, you would use:  

 <!--#flastmod virtual="filename.txt" -->  

This would return: Friday, 06-Sep-96 03:36:06 EDT  

 The CONFIG Command 

The config command is used to control how the results of other SSI are displayed. 
There are three possible arguments: timefmt, sizefmt and errmesg.  

To set the format for the date to dd/mm/yy, you will use:  

 <!--#config timefmt="%d/%m/%y" -->  

The date will now be displayed as: 03/06/97  

The field descriptors used by this SSI tag are the same as those used by the Unix 
date command.  

Notice the dates displayed above this config command use the normal date format, 
the one below it uses the new format.  

To set the format for how file sizes are displayed, you use:  

 <!--#config sizefmt="abbrev" -->  

or:  

 <!--#config sizefmt="bytes" -->  

Depending on whether you want the size given in total bytes or abbreviated as "1k".  

To set error message returned when an SSI tag fails, use:  



 <!--#config errmsg="Error" -->  

A failed SSI tag will now return: Error  

 
 
Reasons for Using SSI: 
SSI is often used to include something into an HTML page. You can insert the 
contents of one HTML page into another page. An example of a practical usage for 
this would be to include your e-mail address at the bottom of each page. If you do 
this as an include, then when your e-mail address changes, you will only have to 
update it on one page and not your entire web site. Another usage is to call cgi 
scripts into action. Many counters, clocks, and other scripts are called using SSI. The 
command used will most likely be provided in the documentation of your cgi script. 
 
More Help for using SSI can be found at: 
http://hoohoo.ncsa.uiuc.edu/docs/tutorials/includes.html 
http//bignosebird.com/ssi.shtml 
http//getscript.com/ssi.shtml 
http//carleton.ca/~dmcfet/html/ssi2.html 
http/sonic.net/~nbs/unix/www/ssi/ 
http//useforesite.com/tut_ssi.shtml 

  

CHAPTER NINETEEN - REAL AUDIO/REAL VIDEO 

  

We DO NOT have Real Audio server software running on our servers. However, you 
can steam RealMedia files by following these instructions: 
 
You will need to create a .ram file that calls your real audio/video file. The .ram file is 
a text file with an absolute URL. This URL will need to be: 
 
http://yourdomain.com/filename.rm 
 
Typically you'll create a realaudio file subdirectory under domain-www, and put all 
your audiofiles there. 
 
Then your .ram file, a.k.a., metafile, will contain an address with this format: 
 
http://yourdomain.com/subdirectory/filename.rm 
 
The "subdirectory" is a subdirectory of your domain-www directory. 
 
So for example: http://yourdomain.com/musicfiles/music.rm Notice: 
The above address goes in the .ram/metafile, not in your HTML code. Your HTML 
code calls the .ram/metafile. Then the .ram/metafile is used to call up the 
.rm/realmedia file. So for example, your HTML code would look something like this: 
 

http://hoohoo.ncsa.uiuc.edu/docs/tutorials/includes.html
http://www.bignosebird.com/ssi.shtml
http://www.getscript.com/ssi.shtml
http://www.carleton.ca/~dmcfet/html/ssi2.html
http://www.sonic.net/~nbs/unix/www/ssi/
http://useforesite.com/tut_ssi.shtml


<a href="http://musicforyou.com/ra/music.ram">Click here to listen to music.</a> 
 
For further support and information, please visit http://www.real.com.  

 
 

CHAPTER TWENTY - POLICY, GUIDELINES, & DISCLAIMER 

 
 

Our Acceptable User Policy and Service Guidelines  

  

SWD HOSTING 
POLICY AND SERVICE GUIDELINES  

SWD Hosting provides web hosting to many clients and we have a 
responsibility to protect each client and to provide the best services 
available. The following guidelines were designed to ensure these 
obligations are met.  

Content 
All services provided by SWD Hosting may be used for lawful purposes only. 
Transmission, storage, or presentation of any information, data or material in 
violation of any United States Federal, State or City law is prohibited. This includes, 
but is not limited to: copyrighted material, material we judge to be threatening or 
obscene, or material protected by trade secret and other statute. The subscriber 
agrees to indemnify and hold harmless SWD Hosting from any claims resulting from 
the use of the service which damages the subscriber or any other party.  

Pornography and sex-related merchandising is prohibited on all SWD Hosting 
servers. This includes sites that may infer sexual content, or links to adult content 
elsewhere. SWD Hosting will be the sole arbiter in determining violations of this 
provision. 

Also prohibited are sites that promote any illegal activity or present content that may 
be damaging to SWD Hosting servers or any other server on the internet. Links to 
such materials are also prohibited. 

Examples of unacceptable content or links:  

• Pirated software  
• Hacker programs or archives  
• Warez sites  
• Any Site that consumes more than 20% of system resources  

Following are a list of sites that will often require more than 20% of our systems 
resources: Multiple domains residing at a single IP address, domains with archives or 

http://www.real.com


galleries, (i.e. .gif, .jpg, .exe, .zip, .tar, etc.), and domain accounts offering 
download files.  

We are not saying that your web site can not contain such files, however if at any 
time they consume 20% or more of our systems resources you will be contacted to 
resolve the problem. 

SWD Hosting will be the sole arbiter as to what constitutes a violation of this 
provision.  

Traffic Usage 
All account plans come with a predetermined amount of traffic allowance. We 
monitor all accounts and bill $10.00 for each gig of traffic exceeded. This amount is 
not prorated, this meaning that 1 mb - 1 gig will be treated and billed as the same. 

Commercial Advertising - Email 
Spamming, or the sending of unsolicited email, from an SWD Hosting server or using 
an email address or domain that is maintained on an SWD Hosting machine as 
reference is STRICTLY prohibited. SWD Hosting will be the sole arbiter as to what 
constitutes a violation of this provision. Our servers may not be the source, 
intermediary, or destination address involved in the transmission of spam, flames, or 
mail bombs. Your domain may not be referenced as originator, intermediary, or 
reply-to address in any of the above. 
Advertising sites on other servers which in turn contain links to a domain on our 
servers is prohibited. We consider spam to be any unsolicited commercial email 
(UCE) or unsolicited bulk email (UBE) in the mediums of Newsgroups, Fax, and 
Email. Distribution of mass emailing programs is also prohibited. 
If you are found to have spammed, then we will immediately, without warning, 
disable your domain. In addition, we will impose a $100 penalty for each spam policy 
violation. 
We reserve the right to refuse or cancel service to known spammers. Lastly, we 
reserve the right to determine what violates this policy. We take pride in having one 
of the strictest anti-spam policies. To report abuses, please contact 
abuse@swdhosting.com. 
As such, any violation will result in immediate deactivation of services without 
refund.  

Chat Rooms 
We do not allow clients to install their own chat rooms. These tend to be a large 
drain on system resources and we cannot allow it as an account option. You are free 
to use the chat room provided on your control panel under the CGI center.  

Background Running Programs 
We may allow programs to run continually in the background. These are considered 
on a case-by-case basis and an extra charge will be incurred based on system 
resources used and operational maintenance needed.  

IRC 
We currently do not allow IRC or IRC bots to be operated on our servers. 



Server Abuse 
Any attempt to undermine or cause harm to a server, or customer, of SWD Hosting 
is strictly prohibited.  

Refusal of Service 
We reserve the right to refuse, cancel, or suspend service at our sole discretion. 

All Sub-Networks, distributive hosting sites and dedicated servers of SWD Hosting 
must adhere to the above policies.  

BILLING 
Recurring Billing: 
We DO NOT send out invoices. All credit cards are billed automatically monthly or 
annually. It is the clients responsibility to ensure that they have sufficient credit to 
cover this transaction. In the event that there is insufficient credit, as a courtesy we 
will send an email notification at which point we will need to be provided with 
another credit card within 24 hours. If we do not receive a response within 24 hours 
the account will be deactivated and any accounts under that account plan.  
 
Account Deactivations: 
Any account deactivated due to non-payment will be deactivated and we require a 
reactivation fee of $50.00 to be paid prior to reactivating the account. 

Refund Policy: 
We do offer a 10 day money back guarantee. 

REFUSAL OF SERVICE 
We reserve the right to refuse, cancel, or suspend service at our sole discretion. 

LIMITATION OF LIABILITY 
SWD Hosting shall not be responsible for any claimed damages, including incidental 
and consequential damages, which may arise from SWD Hosting servers going off-
line or being unavailable for any reason whatsoever. Furthermore, SWD Hosting shall 
not be responsible for any claimed damages, including incidental or consequential 
damages, resulting from the corruption or deletion of any web site from one of SWD 
Hosting servers. All damages shall be limited to the immediate termination of service 

Violations of these Acceptable Uses Policies should be referred to 
abuse@swdhosting.com. All complaints will be investigated promptly. 
Failure to follow any term or condition will be grounds for immediate 
account deactivation. 

DISCLAIMER 
SWD Hosting cannot be held liable for system downtime, crashes, or data loss. We 
cannot be held liable for any predicted estimate of profits in which a client would 
have gained if their site was functioning. You are responsible for keeping a backup of 
your data, data backups are not available. Certain services provided by SWD Hosting 
are resold. Thus, certain equipment, routing, software, and programming used by 
SWD Hosting are not directly owned or written by SWD Hosting. Moreover, SWD 
Hosting holds no responsibility for the use of our clients accounts. If any terms or 
conditions are failed to be followed, the account in question will be automatically 



deactivated. We reserve the right to remove any account without advanced notice for 
any reason without restitution as SWD Hosting sees fit. 

ACCOUNT ACTIVATION 
By activating your account with SWD Hosting, you agree to the above policies and 
disclaimer. Upon requesting an account activation, you are required to accept these 
policies, guidelines, and disclaimer and a copy of your acceptance is forwarded along 
with your activation request to be maintained within your account information. 

NOTICE: If you sign up for an account and do not follow our terms. No refunds will 
be given. We will however let you know by email or phone before any action is taken 
and you will have a chance to solve the matter.  

FURTHERMORE, SWD Hosting retains the right to change any or all of the above 
Polic ies, Guidelines, and Disclaimer without notification. We also retain the right to 
increase any pricing, and make changes to our account plans without notification. 

Failure to follow any term or condition will be grounds for immediate 
account deactivation. 


